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1 Occupational Safety & Health

CHAPTER

The "Golden Rules" of Electrical Safety

» Work Permit (PTW): Never start work on a line without a "Permit to Work" from the Shift
Attendant/Sub-station in charge.

» Dead Line Verification: Always treat a line as "Live" until you have tested it with a neon tester or
discharge rod.

» Earthing for Safety: Before working on a disconnected high-tension line, the line must be Short-
circuited and Earthed to discharge any capacitive charge.

Classification of Fires & Extinguishers
This is a high-yield area for Haryana SSC exams.

Class Type of Fuel Extinguisher to Use

Class A Wood, Paper, Cloth, Trash Water, Foam, ABC Powder
Class B Flammable Liquids (Petrol, Oil, Paint) Foam, CO>, Dry Powder
Class C Gaseous fires & Electrical fires CO2, Halon, Dry Powder
Class D Combustible Metals (Magnesium, Sodium) Specialized Metal Powder

Critical Note: Never use Water or Foam on an electrical fire, as they conduct electricity and can cause a
fatal shock to the operator.

Personal Protective Equipment (PPE)

As per IS: 5983, PPE is mandatory for field staff.

Head Protection: Industrial Safety Helmets (to protect against falling objects).

Foot Protection: Steel-toe leather shoes or rubber boots (Insulated for electrical work).
Hand Protection: Rubber gloves (Tested for specific voltage levels like 11kV or 33 kV).
Eye Protection: Goggles or Face Shields (essential while grinding or battery maintenance).
Fall Protection: Full-body safety harness/belt (Must for ALMs climbing poles).

Treatment for Electric Shock (Artificial Respiration)

If a person is in contact with a live wire, first break the contact using a dry wooden stick or by switching
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off the mains.

» Schaefer’s Method: The patient is placed face down (prone position). Used when there are burns on
the chest.

» Sylvester’s Method: The patient is placed face up (supine position). Used when there are burns on
the back.

» Mouth-to-Mouth: The most effective modern method.

» CPR (Cardiopulmonary Resuscitation): Used if the heart has stopped.

Warning (Danger) Signs

Warning signs are categorized as Cautionary Signs. Their primary function is to alert workers and the
public to hazards that are not immediately obvious but are potentially life-threatening.
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Standard Design Specifications

To identify a genuine Warning sign in an exam or on the field, look for these four specific elements:
» Geometric Shape: Always an Equilateral Triangle.

» Background Color: Safety Yellow (covers at least 50% of the sign area).

> Symbol/Pictogram: Black (placed centrally in the triangle).

> Border: Black (thick outer band).

Common Electrical Warning Signs & Their Meanings

A Training Officer or Shift Attendant must be able to identify these common icons used in Haryana power

substations:

» The Lightning Bolt (Flash): Indicates Risk of Electric Shock. This is found on distribution boxes,
motor starters, and panel doors.

» The Skull and Crossbones: Indicates Danger to Life. Used specifically on High Tension (HT) poles
and transformer fences.

» The Exclamation Mark (!): General Warning. Indicates that you must refer to the manual or proceed
with extreme caution.

» Overhead Symbol: Warning of Overhead Hazards (low-hanging wires or moving cranes).

» Corrosive Symbol: Usually found in the Battery Room; warns of acid that can burn skin.

Legal and Regulatory Requirements (IE Rules)

The display of danger signs isn't just a suggestion; it is a legal mandate under the Indian Electricity Rules

(1956):

» IE Rule 35: Requires "Danger Notices" to be permanently affixed in Hindi, English, and the local
language (Punjabi/Haryanvi) on all installations of medium, high, and extra-high voltage.

» Placement Height: Signs on poles must be placed at a height where they are clearly visible but cannot
be easily defaced or removed (typically 2 to 3 meters from the ground).

» Material: Must be made of weather-resistant materials like Vitreous Enamel or galvanized iron to
prevent rusting and fading.

Hazard Levels: Danger vs. Warning vs. Caution

While often used interchangeably, professional rank files distinguish them as:

1. DANGER (Red/White): Imminently hazardous situation which, if not avoided, will result in death.

2. WARNING (Yellow/Black): Potentially hazardous situation which could result in death or serious
injury.

3. CAUTION (Yellow/Black): Potentially hazardous situation which may result in minor or moderate
injury.

Essential Electrical Safety Rules

For a Training Officer or Shift Attendant, following these rules is mandatory under the Indian
Electricity (IE) Rules.
A. General Safety Rules
v Never work alone: Always have a "standby" person when working on high-voltage equipment.
v’ Insulation check: Before using any hand tool (pliers, screwdrivers), check that the insulation is
not cracked or charred.

v Dead line policy: Consider every wire "Live" until you personally prove it is "Dead" using a
verified voltage tester.

v' Moisture control: Never operate electrical switches with wet hands or while standing on a wet
floor.
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B. Rules for Working on Overhead Lines (ALM Special)
v’ Use of Safety Belt: Always wear a full-body harness when climbing poles.
v' Discharge Rod: After turning off the power, use a discharge rod to connect the line to the earth to
drain any "residual” or "static" charge.
v Ladders: Use only non-conductive ladders (Fiberglass or Wood). Never use Aluminum ladders
near live wires.

The "Four" Categories of Safety Signs

To ensure a high rank in the exam, you must distinguish between all four types:

Sign Category Shape Color Scheme Example

Prohibition Circular Red Border / White Back Do Not Smoke
Mandatory Circular Blue Background / White Symbol Wear Safety Shoes
Warning Triangular | Yellow Back / Black Border Danger: High Voltage
Information Square Green Back / White Symbol First Aid Post

Advanced First Aid & Injury Prevention
The Science of Electrical Injury (Shock)
Understanding the "pathway" of current is essential for a Shift Attendant.
» Path of Current: A shock from "Hand-to-Hand" is more dangerous than "Foot-to-Ground" because
it passes through the heart and lungs.
» Factors affecting Severity:
1. Voltage: Higher voltage breaks skin resistance faster.
2. Duration: The longer the contact, the deeper the tissue damage.
3. Moisture: Wet skin reduces body resistance from 100,000Q to as low as 1,000Q

Systematic First Aid: The DR-ABCDE Protocol

For professional rescuers and ITI-trained staff, the "ABC" is expanded to ensure no hidden injuries are
missed.

» D (Danger): Check for live wires, fire, or gas. Self-preservation is first.

> R (Response): Use the "Shake and Shout" method.

» A (Airway): Use the Head-Tilt-Chin-Lift maneuver. Ensure no broken teeth or vomit blocks the
throat.

B (Breathing): Look for chest rise. If absent, give 2 rescue breaths.

C (Circulation/Compressions): Check the Carotid pulse (neck). If absent, start CPR.

D (Disability): Check for responsiveness using the AVPU scale (Alert, Voice, Pain, Unresponsive).
E (Exposure): Remove clothing near burns, but do not pull away clothes stuck to the skin.

YV V V

Cardiopulmonary Resuscitation (CPR) - Technical Specs

HSSC often asks for specific numbers regarding CPR.

» Compression Depth: 2 to 2.4 inches (5 - 6 cm) for adults.

» Compression Rate: 100--120 compressions per minute (to the beat of "Stayin' Alive").
» Cycle: 30 compressions followed by 2 breaths = 1 Cycle. Perform 5 cycles in 2 minutes.
» Hand Placement: Lower half of the breastbone (Sternum).

Advanced Burn Management

In electrical accidents, Internal Burns are common even if the skin looks okay.

> Entry & Exit Wounds: Current enters at one point and leaves at another (usually the feet). Both need
dressing.
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> Rule of Nines: Used to calculate the percentage of body surface burned (e.g., each arm is 9%, each
leg is 18%).
» DO NOTS:
v Do not use ice (it damages tissue further). Use cool running water.
v Do not pop blisters (this leads to infection).
v Do not apply "Cotton Wool" as fibers stick to the wound. Use Sterile Gauze.

Injury Prevention: The "Hierarchy of Controls"

A Training Officer must know how to prevent injuries using this 5-step ladder:

1. Elimination: Physically remove the hazard (e.g., removing a faulty transformer).

Substitution: Replace the hazard (e.g., using 24V tools instead of 240V in damp areas).
Engineering Controls: Isolate people from the hazard (e.g., putting a fence around a substation).
Administrative Controls: Change the way people work (e.g., safety training, warning signs).
PPE: Protect the worker with gear (The last line of defense).

o wN

Moving forward with the Hand Tools module, which is essential for any Haryana ALM/Electrician
aspirant. In the exam, questions often focus on the correct size, material, and specific application of
these tools.

Hand Tools & Their Specifications

Pliers (The Electrician's Primary Tool)

Pliers are used for gripping, twisting, and cutting wires.

» Combination Pliers: The most versatile. Used for gripping, twisting, and cutting.
v’ Standard Size: 200 mm.
v’ Specification: Must have high-grade PVC insulation (rated for 1000V).
v Note: Never use pliers as a hammer; it damages the pivot and insulation.

» Side Cutting Pliers (Diagonal Cutters): Used specifically for cutting copper and aluminum wires in
confined spaces.

» Long Nose Pliers: Used for holding small parts and making "loops" or "eyes" in wire ends for terminal
connections.

Screwdrivers

» Standard/Flat Head: Used for slotted screws.

Phillips Head: Used for cross-recessed screws.

Specification: For electrical work, the shank must be insulated right down to the tip.

Connector Screwdriver: A small, thin-bladed screwdriver used for fixing wires into terminal blocks
(Connectors).

Y VYV V

Stripping and Crimping Tools

» Wire Stripper: Used to remove the insulation from a wire without nicking the conductor.
V' Auto-adjusting type: Preferred for speed and precision.

» Crimping Tool: Used to fix "lugs" or "ferrules" onto the ends of stranded cables. This ensures a tight,
low-resistance connection.

Striking & Boring Tools

> Ball Pein Hammer: The standard hammer for electricians. Used for punching and riveting.
v' Weight: Usually 400g to 500g for general work.

» Rawl Plug Tool & Jumper: Used for making holes in stone or concrete walls for fixing conduit or
switchboards.

» Center Punch: Used to mark the center of a hole before drilling in metal.
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Measuring & Testing Tools
» Steel Tape: Usually 3m or 5m. Used for measuring conduit lengths and wiring distances.

» Try Square: Used to check the 90circ squareness of a switchboard or conduit layout.
> Neon Tester (Phase Tester): A tool used to check if a wire is "Live."
v' Voltage Range: Typically 100V to 500V.
V' Safety Tip: Never use it without shoes or while standing on a highly insulated mat, as it needs a
tiny bit of "leakage" to ground to glow.

The 5S System (Workplace Organization)

The 5S System is a Japanese methodology used to improve efficiency and safety. HSSC often asks for the
English meaning of the Japanese terms.

Japanese Term | English Meaning | Action in Workshop

Seiri Sort Remove unnecessary tools from the bench.

Seiton Set in Order "A place for everything and everything in its place."
Seiso Shine Clean the tools and the work floor.

Seiketsu Standardize Create a consistent way of doing tasks.

Shitsuke Sustain Maintain the discipline of the first 4 steps.

Hazard Identification & Avoidance

Types of Hazards in Electrical Work

A hazard is anything with the potential to cause harm. For an electrician, hazards are classified into four
main groups:

» Electrical Hazards: Unsafe grounding, exposed live parts, overloaded circuits, and inadequate wiring.

» Physical Hazards: Working at heights (on poles), slippery floors, loud noise (near generators), and
extreme temperatures.

» Chemical Hazards: Battery acid (Sulphuric acid), cleaning solvents, and lead fumes during soldering.

» Mechanical Hazards: Moving parts of motors, fans, or pulley systems.

Hazard Identification Techniques
Before starting any maintenance task, a Shift Attendant must perform a Risk Assessment:

1. Look for "Arc Flash" Potential: Identifying areas where high-voltage current might jump through
the air.

2. Check for "Step and Touch" Potential: Ensuring the ground near a faulty transformer isn't
energized.

3. Visual Inspection: Looking for frayed cables, burnt insulation, or loose terminal connections.

4. Environmental Scan: Checking for water puddles or flammable gases near electrical panels.

Hazard Avoidance (The "Safe System of Work")

Avoidance is achieved through the LOTO (Lock-Out Tag-Out) procedure, which is a favorite topic in
HSSC exams:

» Step 1 (Notify): Inform all affected employees.

Step 2 (Shut Down): Turn off the equipment.

Step 3 (Isolate): Disconnect from the energy source.

Step 4 (Lock/Tag): Place a physical lock and a "DANGER: DO NOT OPERATE" tag. The worker
keeps the key.

Y V V

» Step 5 (Verify): Try to turn on the equipment to ensure it is truly "Dead."
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Personal Protective Equipment (PPE)

PPE is the "Last Line of Defense." It does not eliminate the hazard but protects the worker from injury.

Essential PPE for Electricians (IS Standards)

Body Part | PPE Required Technical Specification (IS Code)

Head Safety Helmet IS: 2925 (Protects against impact and 20kV shock)

Eyes Face Shield/Goggles IS: 5983 (Protects against Arc Flash & acid splash)
Hands Insulated Gloves IS: 4770 (Classified by voltage: Class 0 to 4)

Feet Safety Shoes IS: 15298 (Steel-toe with electrical resistance)

Body Cotton Clothing Avoid synthetics; they melt onto skin during an arc flash.
Fall Full Body Harness IS: 3521 (Used for work above 1.8meters)

Glove Classification

Gloves are rated based on the maximum voltage they can safely handle:

» Class 00: Up to 500V (AC)

» Class 0: Up to 1,000V (AC)

» Class 1: Up to 7,500V (AC)

» Class 2: Up to 17,000V (AC)

Important Note: Always perform an "Air Test" on gloves before use by rolling the cuff toward
the fingers to trap air and checking for leaks.

Waste Disposal & Environmental Safety

Disposing of hazardous waste correctly is part of the 5S Seiri (Sorting) process.

» Cotton Waste/Oily Rags: Must be kept in a covered metal container to prevent spontaneous

combustion.
» Lead-Acid Batteries: Must be sent to authorized recyclers (Lead is toxic).
» Used Transformer Oil: Should never be poured into the ground; it contains PCBs which are
hazardous to groundwater.
» Fluorescent Lamps: Contain Mercury vapor; must be disposed of without breaking.

Personal & Factory Safety

Personal Safety (Worker-Centric)

Personal safety focuses on the individual's habits and gear.

» The "One-Hand" Rule: When working on live panels, keep one hand in your pocket. This prevents
current from forming a path through the chest (heart).

» Jewelry Policy: Never wear rings, metal watches, or chains. These are excellent conductors and can

cause "arc-welding" to your skin if they touch a live terminal.
» Clothing: Use 100% cotton. Synthetic fibers (Nylon/Polyester) can melt into the skin during an
electrical flash.

Factory/Workshop Safety (Environment-Centric)
Safety within the substation or workshop involves structural and procedural rules:

» Insulated Matting: As per IS: 15652, high-voltage switchboards must have "Insulating Mats" in front

of them to isolate the operator from the earth.
» Clearance/Working Space: Adequate space must be maintained around electrical panels (usually 1
meter) to allow for easy escape during an emergency.
» Gangways: Passages must be kept clear of scrap material (wires, old batteries) to prevent tripping.
» Machine Guarding: All moving parts (pulley belts of generators/motors) must be covered with a
mesh guard.
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Effects of Electric Current on the Human Body
The human body acts as a resistor. The effect of electricity depends on the Current (I), not just the
Voltage.

The Threshold Table (Exam-Critical)

Current (mA) Effect on Human Body

1 mA Threshold of Perception: A faint tingling sensation.

5mA Mild Shock: Disturbing but not painful.

10 - 20 mA "Let-Go" Threshold: Muscles contract; victim may not be able to release the wire.
50 mA Severe Pain: Heart and respiratory functions are affected.

100 mA + Ventricular Fibrillation: Heart muscles twitch randomly; usually fatal.

200 mA + Severe Burns: Heart stops completely; severe tissue destruction.

Key Factors Influencing the Effect
> Body Resistance:
v" Dry skin: 100,000 to 600,000Q
v' Wet/Sweaty skin: As low as 1,000Q.
» Duration of Contact: The longer the current flows, the more the internal organs "cook" (Joule's
Heating Effect: H = I2RT).
» Path of Current:
v' Hand-to-Hand: Highly dangerous (passes through the heart).
v" Hand-to-Foot: Highly dangerous (passes through the heart).
v Foot-to-Foot: Known as Step Potential; dangerous during lightning or ground faults.

Reasons For Electric Shock

An electric shock occurs when the human body becomes a part of an electrical circuit, allowing current to
flow through the internal organs. This happens due to a difference in potential between two points of
contact.

Direct Contact with Live Conductors

This is the most common reason for accidents among field staff (ALMs).

» Phase-to-Earth: Touching a single live wire while standing on the ground without insulated boots.
The body acts as a bridge to the earth.

» Phase-to-Phase: Touching two different phases (e.g., Red and Blue) simultaneously. This is
extremely dangerous as the potential difference is much higher (415V instead of 240V).

Failure of Insulation (L.eakage Current)
When the internal insulation of an appliance (like a motor, heater, or transformer) fails, the metallic outer
casing becomes energized.

» Reason: Aging of wires, overheating, or mechanical damage.

» The Hazard: If the equipment is not properly Earthed, a person touching the casing will receive a
shock.
» Safety Measure: Proper Earthing and use of ELCB/RCCB (Earth Leakage Circuit Breakers).

Step and Touch Potential (Substation Hazards)
In high-voltage substations, shocks can occur even without touching a wire directly.
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» Step Potential: During a ground fault (e.g., a wire falls to the ground), the voltage is highest at the
point of contact and decreases as you move away. If a person walks near this area, the distance between
their feet creates a "potential difference," and current flows from one leg to the other.

> Touch Potential: This occurs when a person touches a grounded metallic structure (like a transformer
fence) while a fault is occurring. The voltage difference between the hands and the feet causes the
shock.

Capacitive Discharge (Residual Charge)

Even after the power is switched off, certain components can store electricity.

» Capacitors: Large capacitor banks used for power factor correction can hold a fatal charge for minutes
or hours.

» Long Underground Cables: These act like giant capacitors.

» Reason for Shock: Touching the terminals before they are "Discharged" to the ground.

> Prevention: Always use a Discharge Rod before starting work.

Static Electricity

» Reason: Friction between moving parts (e.g., a leather belt on a pulley) or moving fluids in a pipe can
build up high-voltage static charges.

» The Hazard: While usually not fatal, the sudden "jerk" from a static spark can cause a worker to fall
from a height.

Human Factors & Environmental Conditions

» Moisture/Perspiration: Pure water is a poor conductor, but sweat contains salts. Wet skin drops body
resistance from 100,0002 to nearly 1,000Q increasing current flow drastically.

» Incorrect Tools: Using a screwdriver or plier with cracked or poor-quality insulation.

» Lack of LOTO: Someone accidentally switching on the power while a technician is working on the
line.

Disposal Procedure of Waste Materials

Proper waste disposal follows the 3R Principle (Reduce, Reuse, Recycle) and is a core component of the
5S Methodology (specifically Seiri - Sorting).

Classification of Workshop Waste

Electrical workshops generate three main types of waste:

» Non-Hazardous: Paper, cardboard packaging, plastic insulation strippings.

» Hazardous (Chemical/Toxic): Used battery acid, lead-acid plates, used transformer oil.
» Flammable: Oily cotton waste, grease-soaked rags, solvents.

Standard Disposal Methods
A. Oily Cotton Waste & Rags
This is the most dangerous waste in a substation due to Spontaneous Combustion (catching fire
without an external spark).
v Procedure: Must be collected in Closed Metal Bins (not plastic).
v Disposal: Should be incinerated in controlled industrial environments or cleaned for reuse if
possible.
B. Used Batteries & Lead Acid
Under the Batteries (Management & Handling) Rules, these cannot be thrown in regular trash.
v Acid: Before disposal, Sulphuric acid (H2SO4) must be neutralized using an alkaline solution
like Soda Ash or Lime.
v" Lead: Highly toxic. Old batteries must be returned to the manufacturer or sent to authorized recyclers.

ToppersNotes / 9828-286-909 8



C. Transformer Oil (Mineral Oil)
v Procedure: Used oil contains PCBs (Polychlorinated Biphenyls). It must be collected in leak-
proof drums.
v' Disposal: Never pour oil onto the ground (it contaminates groundwater). It should be sent for "re-
refining" or professional disposal.
D. Metal Scrap (Copper/Aluminum)
v Procedure: Segregate based on the metal type.
v" Dispesal: Sold to scrap dealers for melting and recycling. This is high-value waste.

Color Coding for Waste Bins (IS Standard)

For the exam, memorizing this table is essential for the "General Awareness/Safety" section:

Type of Waste Bin Color

Paper Blue

Plastic Yellow

Metal Red

Glass Green

Food/Organic Black

Hazardous/Electrical Grey/Orange (Specific to site)

Hazard Identification Symbols for Waste

Waste containers must be labeled with the correct hazard symbol:
» Flame Symbol: For flammable rags/solvents.

» Skull and Crossbones: For toxic lead or chemical waste.

» Corrosive (Hand/Metal being eaten): For battery acid.

Emergency Response Procedures

Electrical Shock Emergency

If you see a colleague in contact with a live wire, never touch them directly.

> Step 1: Isolate (The Most Critical Step): Turn off the main switch or circuit breaker immediately. If
the switch is far away, use a non-conductive object (dry wooden stick, plastic pipe, or rubber mat) to
pull the victim away or push the wire.

» Step 2: Check Vital Signs: Once clear, check for Airway, Breathing, and Circulation (Pulse).

» Step 3: Medical Intervention: * If not breathing: Start CPR (30 compressions : 2 breaths).
v" If breathing but unconscious: Place in the Recovery Position.

» Step 4: Treat Burns: Electrical burns are internal. Cover the entry and exit wounds with a clean, dry
cloth. Do not apply ointments.

Fire Emergencies

Fires in electrical installations are Class C (per Indian Standards) or PA.S.S. METHOD
Class E (International). Mledede

HOW TO USE A FIRE EXTINGUISHER

» Immediate Action: Raise the alarm (Shout "Fire! Fire!") and isolate
the power source. Iﬁa—
» Selecting the Extinguisher:
v' DO USE: CO2 (Carbon Dioxide) or Halon/Dry Chemical Powder
(DCP) extinguishers. | A THE BASE OF FiRE
v" NEVER USE: Water or Foam (they conduct electricity and will
cause further shock).
» Technique: Use the P.A.S.S. method (Pull, Aim, Squeeze, Sweep).
» Evacuation: If the fire is large, evacuate immediately. Crawl low to
avoid inhaling toxic smoke. : :

<)
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Battery Room Emergencies (Chemical/Explosion)

Lead-Acid batteries release Hydrogen gas during charging, which is highly explosive.

» Acid Splash: If electrolyte (Sulphuric Acid) splashes on skin or eyes, wash with clean running water
for at least 15-20 minutes continuously.

> Explosion/Fire: If a battery explodes, evacuate the room to avoid inhaling lead and acid fumes. Use
a Class D or specialized extinguisher if metal fires occur.

» Ventilation: Immediately turn on exhaust fans or open windows to disperse hydrogen gas.

Falls from Height (ALLM Special)

If an ALM falls from a pole:

» Immobilization: Do not move the victim. There may be a spinal or neck injury.

» Check for Bleeding: Apply direct pressure to any open wounds.

> Treat for Shock: Keep the victim warm with a blanket and elevate their legs slightly (unless a leg
fracture is suspected).

Reporting and Documentation

After the emergency is controlled, legal procedures must be followed:

» Inform Superior: Report to the Junior Engineer (JE) or SDO.

» Logbook Entry: Record the time, nature of the fault, and action taken in the Station Log.
» Accident Report: Fill out the mandatory accident report form as per IE Rule 44A.

Emergency Equipment Checklist

Equipment Purpose

First Aid Kit Bandages, Antiseptics, Sterile Gauze.

Stretcher To transport injured persons without further injury.

Fire Buckets Kept filled with Dry Sand to smother small oil/electrical fires.
Rubber Gloves/Mats Kept near the main panel for emergency isolation.

Emergency Lights Must be functional in case of a total blackout (Grid Failure).

Response to Technical Emergencies

Power Failure (Grid/Substation Blackout)
A power failure can range from a local feeder trip to a total grid collapse.
» Initial Action: Identify if the failure is "External" (Grid side) or "Internal" (Local fault).
» Safety Check: Ensure all heavy motor loads and capacitors are disconnected to prevent a surge when
power returns.
» Procedure:
1. Check the Annunciator Panel to see which relay tripped (Overcurrent, Earth Fault, etc.).
2. Check the Battery Bank Voltage: During a blackout, the DC system must stay alive to operate
the protection relays and breakers.
3. Restoration: Follow the "Load Shedding" protocol. Always energize the Busbar first, then the
Transformers, and finally the Feeders one by one.
» Communication: Immediately inform the Load Dispatch Center (LDC) and record the "Trip Time"
in the logbook.

Fire Emergencies (Electrical & Qil Fires)
Fires in substations are usually caused by insulation failure, overloading, or transformer oil leakage.
» The "Golden Rule": Never use water on live electrical equipment or oil fires.
» Classification:
1. Class C (Electrical): Use CO2 or Dry Chemical Powder (DCP).
2. Class B (Oil Fires): If a transformer catches fire, use Foam or DCP.
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> Response Steps:
3. Isolate: Hit the Emergency Trip Button to de-energize the entire section.
4. Contain: Use Sand Buckets to prevent oil from spreading.
5. Extinguish: Use the P.A.S.S. technique (Pull, Aim, Squeeze, Sweep).
6. Cooling: For large transformers, the Mulsifyre System (Water spray) may be used, but ONLY
after the power is confirmed OFF.

System Failure (Protection & Control)

System failure refers to the breakdown of the "brains" of the substation (Relays, DC system, or SCADA).

» DC System Failure: This is the most dangerous failure. Without DC power, the Circuit Breakers
cannot trip automatically during a fault.

v" Action: Switch to manual operation and try to restore the Battery Charger.

» Relay Malfunction: If a relay fails to trip during a fault, it leads to a "Busbar Fault," which can destroy
the transformer.
v" Action: Use the Backup Protection or manually trip the upstream breaker.

» CT/PT Failure: If a Current Transformer (CT) secondary opens, it creates dangerously high voltage
and can explode.
v’ Action: Never open the secondary of a live CT. If it happens, de-energize the primary immediately.

Emergency Equipment & I.egal Rules

Emergency Critical Tool/Rule Purpose
Total Blackout Emergency To maintain visibility for the operator.
Lights/Inverter

Transformer Fire Soak Pit The gravel pit under a transformer designed to drain and
cool burning oil.

System Fault Buchholz Relay Protects the transformer from internal gas/oil pressure
faults.

All Emergencies IE Rule 44 Mandatory display of shock treatment and emergency
charts.

Concept of Standards (BIS/ISI)

Standards are a set of rules or guidelines that ensure electrical products are safe, reliable, and of good
quality. In India, the Bureau of Indian Standards (BIS) is the national body.

What is BIS and ISI?

» BIS (Bureau of Indian Standards): The organization that sets the quality standards.
» ISI Mark: A certification mark for industrial products in India. If an electrical appliance (like an iron

or a motor) has the ISI mark, it means it has passed safety and quality tests.

Advantages of BIS/ISI for Electricians:

1. Safety: Ensures the insulation can withstand the rated voltage without leaking.

2. Reliability: ISI-marked cables have a guaranteed current-carrying capacity.

3. Interchangeability: Standards ensure that a 5A plug from one brand will fit into a 5A socket from
another.

4. Legal Protection: For government projects (like those in HVPNL/UHBVN), using non-ISI marked
material is a legal violation.

5. Reduced Losses: Standardized conductors have fixed resistance values, reducing I2RT (heat) losses.
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Signs and Symbols of Electrical Accessories

Recognizing symbols is the most important skill for a Shift Attendant reading a single-line diagram
(SLD).

Common Schematic Symbols:

Ammeter: A circle with 'A" inside (Connected in Series).

Voltmeter: A circle with 'V' inside (Connected in Parallel).

One-Way Switch: A circle with a single diagonal line and a dot.

Two-Way Switch: A circle with two diagonal lines (used in staircase wiring).
Socket Outlet (5A/15A): A semi-circle with two or three pins.

Earth Point: Three horizontal lines of decreasing length (the "Tree" symbol).
Fuse: A rectangle with a line passing through it.

Circuit Breaker: A cross inside a square or a specific toggle symbol.

Introduction to the 5S Concept
Originating from Japan, the 5S Concept is a workplace organization method used to improve efficiency
and safety in electrical workshops and substations.

YVVYVVYVYYY

Japanese English Term Meaning for an ALM/Electrician

Term

Seiri Sort Remove broken insulators, burnt fuses, and scrap wire from the
floor.

Seiton Set in Order Keep pliers, testers, and hammers on a shadow board. "A place
for everything."

Seiso Shine Clean oil leaks from transformers and dust from insulators to
prevent tracking.

Seiketsu Standardize Use the same color coding for wires (R-Y-B) across all panels.

Shitsuke Sustain Follow these rules every single day without being told.
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2 Fundamental of Electricity

CHAPTER

Electricity

Switch

'

Battery

Simple Electrical
Circuit

Wire

Light
Bulb

Effects of electric Current

v

Heating effect

v

\ 4

Chemical effect

v

Electric Iron, Heater,
Toaster, sandwich maker

Lead accumulator
(Charging of Cell)

Electricity is the flow of electric charge (electrons) through a conductor.

» Direction of electron flow: Negative — Positive
» Conventional current direction: Positive — Negative

Fundamental Terms
Electric Charge (Q)

v

Magnetic Effect

v

Electric Bell, T.V. Radio,
Telephone etc.

» Property of matter due to which it experiences force in an electric field

» Unit: Coulomb (C)
> Charge of 1 electron = -1.6 x 107° C

Electric Current (I)

» Rate of flow of charge
» Formula: I = Q/t

» Unit: Ampere (A)

» 1 Ampere = flow of 1 Coulomb charge per second

Voltage (V)

» Potential difference between two points
» It drives current in a circuit

» Unit: Volt (V)
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Resistance (R)
» Opposition offered to flow of current
» Unit: Ohm (L2)

Conductance (G)
» Reciprocal of resistance G = 1/R
» Unit: Siemens (S)

Power (P)

> Rate of electrical energy consumption P = VI

» Unit: Watt (W)

Energy (E)
E=PXt=VIt
» Unit: Joule (J) or kWh

Units & Standard Values

Quantity Symbol Unit Expression
Charge Q Coulomb [xt
Current I Ampere Q/t

Voltage \Y Volt W/Q
Resistance R Ohm Vi

Power p Watt VI

Energy E Joule VIt

Effects of Electric Current

Heating Effect
» Current produces heat in conductor
» Used in: Heater, Iron, Fuse
» Formula:
H =I’Rt

Magnetic Effect
» Current produces magnetic field
» Used in: Motor, Transformer

Chemical Effect
» Current causes chemical changes
» Used in: Electroplating, Batteries

Physiological Effect
» Electric shock affects human body

Types of Resistors

Wire carrying electric current

Battery

Compass needle

Magnetic field

CERAMIC SUBSTRATE METAL FILM EPOXY COATING
RBERINS INSULATION
N )
s
Ceifnusﬁ CAP AND LEAD WIRE KEADs
END
CARBON FILM END CAP CERAMIC
Carbon Film Resistor Metal Film Resistor
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